
  

 

2010-15 Camaro 3.6 Supercharger Kit Installation Guide 

 

 

Thank you for purchasing the Overkill supercharger system for your 6th gen 
Camaro V6. This installation guide will help you through the install, but reach out 
to me, Will, at willoverkill@gmail.com should you have any questions that I can 

help resolve. Installation is recommended by a professional mechanic, or at 
minimum an experienced DIY mechanic with good problem solving skills. 



LEGAL DISCLAIMERS AND IMPORTANT INFORMATION, PLEASE READ BEFORE 
INSTALLING THE SUPERCHARGER SYSTEM!! 

- Use extra caution when driving any modified vehicle. Increased power will quickly 
produce increased vehicle speeds that may make the vehicle unsafe or 
uncontrollable. Overkill does not condone speeding or breaking any traffic laws. 
Please, drive with care, responsibly enjoy, be safe.  

- Overkill is not liable for any damages as a direct or indirect result of installing this 
supercharger. The purchaser, installer or reseller of this supercharger system 
cannot, under any circumstances, hold the companies mentioned liable for any 
subsequent loss, damages, fines or penalties. This includes any mechanical 
failure to any component of your vehicle. It is the responsibility of the purchaser, 
owner or operator of the vehicle being modified to understand all risks associated 
with increasing the horsepower of a vehicle on this scale. 

- This supercharger system is NOT CARB approved and is not legal for use on 
any public roads in the state of California. This system has not undergone any 
approval for use on public roads. All efforts have been taken to ensure no 
increased emissions from normal vehicle operation. It is the responsibility of the 
purchaser, owner or operator of the vehicle being modified to understand and 
comply with all emissions laws associated with their vehicle. 

-  Use of 91 octane or higher is REQUIRED with this supercharger system. Do not 
use 87 octane, 89 octane, or E85 ethanol fuel. For all forms of racing or 
sustained high speed use, it is recommended to use a mixture of 100+ octane 
unleaded race fuel and the highest octane pump gas available.  

- Installation of this system by a trained certified mechanic is HIGHLY 
RECOMMENDED. It is the responsibility of the purchaser, owner or operator of 
the vehicle being modified with this supercharger system to ensure the safe and 
proper installation of this system to avoid damage to any of its components which 
may not be covered under warranty due to installation error or abuse. 

- Horsepower figures quoted are not guaranteed. Overkill does not “fluff” these 
figures, they are a realistic expectation of a vehicle in excellent mechanical 
condition with no abnormal mechanical deficiencies, a correct and quality 
installation with no boost leaks or belt slip, and fully tuned by Overkill or by a 3rd 
party to the standards of Overkill. However, vehicles with issues related to the 
exhaust system, knock sensors, excessive carbon buildup (pistons, intake 
valves), reduced compression ratio from factory specs etc may need additional 
work to see these horsepower gains. The older the vehicle is, the more you 
should anticipate these issues to arise. Do not be discouraged, but be aware! 

 



Installation Overview 
Before you Begin: Ensure you read and ask any questions you have! 
Step 1: Read Factory Computer Tuning 
Step 2: Remove Front Bumper 
Step 3: Remove Air Filter Assembly 
Step 4: Install New Power Steering Reservoir System 
Step 5: Install New Upper Coolant Hose and Radiator Brackets 
Step 6: Install Crankshaft Pulley 
Step 7: Install Tensioner To Mounting Plate 
Step 8: Install Mounting Plates and Vortech 
Step 9: Remove Washer Fluid Reservoir 
Step 10: Remove Bumper Crash Support and Prep for Intercooler 
Step 11: Install Front Intercooler and replace Bumper Crash Support 
Step 12: Install Driver’s Side Intercooler Piping 
Step 13: Install Passenger’s Side Intercooler Piping 
Step 14: Install Throttle Body Spacer and MAF 
Step 15: Modify A/C Line  
Step 16: Install Air Filter and Intake Tubing 
Step 17: Install Catch Can System and Hoses 
Step 18: Install Spark Plugs, Install MAP Sensor (2012-15 Only) 
Step 19: Install Washer Fluid Reservoir 
Step 20: Reinstall Front Bumper 
Step 21: Fill with oil and Final Checks 
Step 22: Flash Tuning File 

Before you begin the installation, ensure that you have followed the included 
instructions to read the factory computer tuning from your vehicle and emailed it to 
willoverkill@gmail.com and waited to receive your new supercharged tunes back 
before attempting to install. This process may take several business days.  

Disconnect your battery before starting the installation. Remove the negative 
battery terminal and place a clean towel on the battery post to prevent contact.  

From your dealership, you will need 500ml to a quart of power steering fluid 
applicable to your year Camaro, plus a jug of Dexcool coolant, ideally premixed. 

Recommended items to have: Blue Loctite, Dielectric Grease, WD40, Spark Plug 
Gapping Tool, Electrical Tape, A Sharp Razor Blade, Allen Socket and Torx Socket 
Bits for 3/8” Rachet, Torque Wrench, Full Socket Set, Sturdy Scissors, Tub to catch 
oil that will drain, Zipties 

 

mailto:willoverkill@gmail.com


Step 1: Install Your Tuning Software and Read the Factory Tuning 

Before you start doing the installation, you must first read the factory tuning from 
your vehicle to send to Overkill so that I can begin to write your new tuning while 
you’re doing the installation. Do NOT make this the last step and then be concerned 
when you’ll get the new tuning back because the car isn’t drivable after the install 
without it, do this first!  

Follow the additional instructions provided to operate the HP Tuner suite 

 

Step 2: Remove Front Bumper 

Reference the following image: 

 

#1 In Photo – Remove 6 push-in retainers from upper support 

#2 In Photo – Remove 2 Screws from upper support 

#6 In Photo – Remove 2 Screws from lower bumper 



 

 

Remove the screws that line the inner fenderwell skirt and peel back (Tip: Turn the 
wheels to aid access to these screws), then remove the bolt marked #4 In Photo 

 

From the passenger’s side, unplug the main harness connector 



 

 

Your front bumper cover will now be loose and free to remove. Recommend you set 
it down on a cloth or on the grass on lawn, and away from the work area so not to 
damage its finish! 

 

Step 3: Remove Air Filter Assembly 

Remove the oil filler cap, pull up on and slide forward the engine cover to remove, 
then reinstall the oil cap to prevent debris falling in. 

Remove the breather hose from the air duct on the driver’s side of the duct by the 
throttle body, loosen the clamps at the throttle body and air filter housing and 
remove the duct. 

Unplug the MAF sensor connector on the air box, loosen the two nuts on the strut 
tower and then pull up and remove the entire air box.  

 



 

 

Step 4: Install new Power Steering Reservoir System 

Next we’re removing the factory power steering fluid reservoir and associated hoses. 

 

 



Begin by draining the reservoir of fluid. Remove the smaller hose from the reservoir and 
use a tub, cup or bottle to catch the fluid (tip: keep the cap on to slow the initial drain of 
fluid from the reservoir, then remove the cap to accelerate draining). Lower the hose to 
catch as much fluid from inside as possible, then push aside. Remove the larger hose 
from the reservoir and do the same. 

Remove the reservoir from its bracket by pressing the retaining clip with a flatblade 
screwdriver and slide the reservoir up and off. Then remove the two 10mm bolts holding 
the black bracket on. 

Reference the following picture, you’ll need now to remove a 10mm bolt and slide it 
through the opening in the pulley and out, it will not be reused. Then look for the black 
bracket at the side of the engine attaching to the power steering pump, remove the 
15mm bolt and torx bolt (save for reuse), and remove the hose and its fitting.  

 



 

We’ll now begin to install the new power steering reservoir system. Start with the new 
pump fitting, it’s a one piece fitting with an Oring installed, and a C-clip retainer plate. 
Install the fitting in the pump, slide the retainer plate inplace and secure with the new 
bolt included (or you can use the old Torx bolt).  

 

 



Next, mount the bracket for mounting the new fluid reservoir. Go back to the brake 
master cylinder; from the engine side, remove the nut securing the master cylinder to 
the brake booster. Slide the new bracket inplace over the stud, and note the two forks 
fitting around the casting to prevent the bracket from rotating. Reinstall the nut. (Note 
this picture shows the old bracket, not the new stainless bracket) 

 

You’ll need to use the new fluid reservoir as a guide as you bend the A/C lines out of 
the way. Use light to moderate pressure and push the lines over to make room for the 
new reservoir. Once space is created, the reservoir will sit right beside the brake fluid 
reservoir like this… 

 



The large hose runs from the reservoir to the pump fitting previously installed. With a 
clamp slide over, install this end onto the fitting installed in the pump; ensure to angle 
the hose upward and prevent any low spots in the hose between the fitting and 
reservoir. Trim the hose to length at the reservoir end using good scissors, razor blade, 
or a proper hose cutter, slide over a clamp and slide over the reservoir fitting, and finally 
secure at both ends by tightening the hose clamps. If you’re having difficulty maintaining 
the bend in the hose out of the pump, you can pick up one of these 5/8 unicoils from 
Continental at a parts store to make a permanent bent without kinking the hose. 

 

 

 



Finish with the smaller hose. It’s suggested to run the hose right from the reservoir to 
the oil cooler up front. You can alternatively use the included 3/8” barbed hose joiner to 
secure to the hose end that you took out of the factory reservoir. If the former, remove 
the 10mm bolt securing the old hose next to the radiator, and remove. Trim the hose to 
desired length and route/secure as desired away from moving parts. 

 

 

Step 5: Install New Upper Coolant Hose and Radiator Brackets 

Use a tub or container to catch the old coolant as it comes out of the old upper coolant 
hose. Remove one end at a time, catch the coolant for disposal, and save the clamps. 
Install the new coolant hose with the bigger end on the engine side and smaller end on 
the radiator size, with the clamps from the old hose. Remember to check your coolant 

level at the end of the installation.

 



Next, locate the factory upper radiator brackets at the top of the rad, they’re held on by 
one 10mm bolt each that you’ll remove. There’s a locator tab holding the brackets to the 
body, the bracket will need to come forward away from the body first to dislodge it and 
then they can be pulled up and off of the locating stud on the radiator itself; I find it best 
to remove both bracket bolts to allow the rad to move forward a little, grab the top of the 
bracket and rotate it forward off of the radiator mounting stud.  

Once both sides are off, locate the new upper radiator brackets on the kit, these will 
lean the radiator back a little for more clearance to the supercharger. Slide them over 
the radiator stud first, then gently lean back the rad and reinstall the 10mm bolt. If you 
feel too much resistance on the radiator leaning back before the bracket is flush with the 
body, you can use 3/8” washers to space the bracket away from the body. 

 

 

 

 

 

 

 

 

 

 



Step 6: Install Crankshaft Pulley 

One of the harder parts of the installation will be removing the crank pulley bolt. Using a 
strong impact gun ideally, remove the bolt; if you don’t have enough room to get the 
impact gun in there straight, you can remove the cooling fans with 2 minutes work and 
gain lots of room.. The new pulley will index into the OEM crank pulley spokes. Once 
the new slip fit pulley feels slotted in and sits flush with the OEM crank pulley, install the 
new factory bolt provided (with some Loctite suggested) and torque to factory 
specifications of 74 ft-lbs and an additional 150 degrees rotation. Personally I just put it 
on with an air impact using my judgement, however if you ask me what the torque 
should be, my official answer will be the factory specification.  

 

 

 

 

 

 

 

 



Step 7: Install Tensioner To Mounting Plate 

To prepare to install the mounting plates, first attach the tensioner assembly to the outer 
face plate with the Procharger attached. The tensioner will mount on the plate on the 
side where the Procharger’s pulley is, and both that pulley and the tensioner pulley will 
face the same direction. Use the included 3 bolts from the fastener’s kit and torque to 8 
ft-lbs or 96 inch-lbs with blue Loctite recommended. Don’t overtorque these little bolts! 

 

 

Step 8: Install Mounting Plates and Vortech Unit 

Time to install the good stuff! Once installed, the plates will look like this, OF COURSE 
YOU”LL HAVE THE PROCHARGER ATTACHED TO IT, but this gives you an idea.. 

 



Identify first the components, you’ll have:  

- the Procharger pre-attached to the “outer plate” (and tensioner now attached) 

-two piece “inner” or “engine side” plate with a rectangular block held on with two bolts 

-2 long round spacers with smaller inner diameters 

-1 long round spacer with a larger inner diameter 

-2 thick aluminum M8 washers 

-2 M8 socket head cap screws 

-1 M10 socket head cap screw (shorter and slightly fatter than above) 

-1 very long and big M12 screw with a flat top countersunk head 

Blue Loctite is recommended on all of the following bolts. 

First, remove the bolt at the side of the engine above the steering pump (shown Step 4). 

You’ll also need to remove a large bolt from this location on the front of the engine 
cylinder head in the power steering pump vicinity. 

 

Grab the 2 M8 screws, the thick washers and the smaller diameter spacers; you’re 
going to use these to fasten the two plates together before installing. Slide the washers 
on the bolts first, then pass the bolts through the backside (the side the rectangular 
block is attached to) of the upper holes, slide the spacers over the bolts, put a little 
Loctite on the threads, line up with the outer (supercharger side) plate and fasten 
together with the bolts finger tight.  



*Special Note for D-Series Stage 3 Prochargers* The larger pulley makes for a close 
tolerance to the plate spacers. Check and ensure if you can slide the belt around the 
pulley with the spacers in place, and if not you’ll want to place the bent over the pulley 
and then put the spacers in place, just keep the belt out of the way during the install. 

Place the larger diameter spacer between the plates and pass the larger M12 screw 
through the front side of the outer plate (the side that the Procharger is mounted to), 
through the spacer and finally the inner plate.  

Ready to offer them to the engine? Using the spacers as handles, lift the assembly into 
the engine bay, and begin to thread the M12 screw into the bolt hole at the front of the 
engine pictured above. Don’t fully secure yet.  

Grab the M10 socket cap screw, this will pass into the side of the rectangular block and 
into the side of the engine where you previously removed a bolt above the power 
steering pump. Use an 8mm Allen head socket bit to tighten this screw first to 22 ft-lbs, 
then go back to the M12 screw and tighten it to 35ft-lbs with the same socket bit. Using 
a 3/16 Allen socket bit, ensure the two screws holding the engine plate’s rectangular 
block are tightened to 17 ft-lbs, and then complete by tightening the M8 screws up top 
with a 6mm Allen socket bit to 17 ft-lbs. 

You can now install the 8-rib belt. Install over the supercharger pulley first, then with the 
tensioner rotated clockwise with a 3/8 rachet slide the belt over the crank pulley to the 
inner most ribs and release the tensioner. Check belt alignment to ensure it will run 
straight and adjust on the crank pulley as required. 

 

Step 9: Remove Washer Fluid Reservoir 

On the driver’s side in the fender well, you’ll see the factory washer fluid reservoir that 
needs to be removed. Drain the washer fluid by removing the fluid line from the pump or 
removing the pump completely from the reservoir, just be prepared for the swift 
evacuation of the fluid and don’t get wet. Unplug the electrical connector from the pump. 
Remove the three bolts you see on reservoir body and remove from vehicle. 

 



Step 10: Remove Bumper Crash Support and Prep for Intercooler 

Remove the 6 bolts on either side of the front crash support brace, which is the big 
metal bracket that’s running side to side infront of the radiator. Remove completely so 

you can install the intercooler.

 

You’ll also need to remove this large piece of air deflector plastic to make room for the 
intercooler. 

 

 

 

 

 



Step 11: Install Front Intercooler and replace Bumper Crash Support 

With the crash bar out, place the intercooler back in behind where the crash bar sits. 
The intercooler will sit onto a square metal bracket that the plastic bolted to. Optional is 
to drill holes and use the extra included bolts to secure to the crash bar; if you choose to 
just rest the intercooler on it, that’s ok too, it won’t be going anywhere with the upper 
brackets installed.  

*Note* It’s suggested that you wait to securely mount the intercooler until the tubing is 
run, incase you find it beneficial to move the intercooler to favor one side instead of 
being perfectly center… should you do this, simply come back to this step towards the 
end of the installation. 

Reinstall the crash bar and its bolts. Install the 2 Z brackets onto the upper intercooler 
mounting points using the included bolts. With the intercooler positioned where you 
want it, use the included drill bit and tap and drill down into the crash bar and tap a 
thread, then install the bolts and snug but do not overtighten. Blue Loctite is 
recommended.  

 

 



 

 



Step 12: Install Driver’s Side Intercooler Piping 

Tips: Use WD40 to provide a temporary lubricant to install and locate the silicone tubes 
over any metal pipe connections. When tightening the clamps, there will be two stages 
of “tight”; you’ll find the clamps lose their slop over the silicone tube but as you keep 
tightening you’ll find the resistance on the clamp nut doesn’t increase, this is when the 
clamp is compressing the silicone tubing. You’ll want to keep tightening until you feel a 
true resistance and tightening on the clamp nut. I don’t have a specific torque spec to 
suggest, but the clamp manufacturer suggest 70 inch-lbs. 

It’s time to install the intercooler piping, start on the driver’s side to connect the 
supercharger outlet to the intercooler. The tubing will go as follows: Mild bend silicone 
elbow (orange inside) –into—Aluminum 90 degree elbow –into—180 degree silicone 
elbow. You’ll need 4 smaller clamps that say 87/79 on the band  to secure. 

The mild bending silicone elbow goes over the Procharger outlet and connects to the 
aluminum pipe; aim the bend forward towards the radiator. Slide the aluminum elbow up 
into the other end of the mild bend silicone elbow, and rotate them to manipulate the 
angle as you need to get a good fit for the 180 elbow to slide onto the aluminum elbow 
end and the intercooler end. You can trim the leg lengths of the 180* elbow to get a 
better fit should you need to. Secure all connections by tightening the clamps. 

 



 

 



Step 13: Install Passenger’s Side Intercooler Piping 

Moving to the passenger’s side, you’ll need the following components to go from the 
intercooler into the engine bay: smaller 90 degree Cobra head silicone elbow  –into—
Preassembled Blow-Off Valve tube –into— the long preformed silicone tube with the 90* 
bend at the blow off valve end –into— the metal silicone joiner ---into--- 90* reducing 
elbow –into—MAF housing –into—90* reducing elbow. Leave the MAF and final 90* 
elbow off for now, they will be installed shortly. 

The blow off valve will be positioned in the passenger’s fenderwell, with the tube 
running roughly parallel to the ground and front/back with the direction of the vehicle.  

 

 

Prep this area first by bending this tab on the body and it’s highly recommended that 
you cut the triangle tip off of the subframe to create a little more room for the tubing to 
pass through, but not 100% necessary. You’ll see we use an electric sawzall and blade, 
but a good hacksaw will do perfect as well. A metal grinder……..eeeehhh……but either 
way, be careful to only cut what you intend to cut!  



 



Start by sliding the long preformed silicone tube down from inside the engine bay until it 
pokes through to the fender well, you can use some WD40 spray on the outside of the 
silicone tube to help glide it past the subframe to where it needs to be. Next, 
preassemble the BOV valve tee into the Cobra head 90* elbow, it goes into the short 
end of the head, with a clamp.  

Ensure to use a clamp on every following connection. Place the long end of the Cobra 
elbow onto the intercooler outlet and the other end of the blow off valve into the long 
preformed tube you just positioned in place, ensure to use some WD40 on all 
connections! You’ll now need to slide and rotate as required to get a good fit, you’ll want 
the other end of the long preformed hose in the engine bay to be facing slightly forward 
towards the front of the vehicle but otherwise quite vertical in its posture. Once you’re 
satisfied you’ve accomplished this, tighten the clamps in sequence to secure.   

 

 



Step 14: Install Throttle Body Spacer and MAF  

A throttle body spacer is provided to provide engine vacuum to the blow off valve. Open 
the kit, it’ll have a spacer with fitting preinstalled, a gasket and longer bolts. Remove the 
throttle body by removing the 4 securing bolts. Install the spacer with the vacuum fitting 
and hose facing the passenger’s side of the vehicle. Secure the throttle body using the 
longer provided bolts, with the provided gasket between the throttle body and plate, and 
the factory rubber seal sealing the plate to the intake manifold. The included hose will 
run to the blow off valve. 

 

2012-15 - Remove the MAF sensor from the factory air filter housing use a torx bit. Note 
the included wiring extension harness to reach the new location.  

2010-11 – Your kit comes with a new MAF. Remove the new MAF from its box and note 
the included wiring extension harness. You do not reuse your original MAF sensor.  

Note the direction of the sensor and the open window with element that was facing 
towards the air filter. Install into the new MAF housing with that window facing the 
screen mesh on the one end of the new housing.  

Install the MAF into the 90* silicone elbow you left off with from Step 14 with the screen 
end facing into this elbow. The MAF should have the sensor’s electrical connection 
pointed upward and slightly toward the engine as desired. Use the metal joiner to 
connect the other end of this 90* silicone elbow to the mild bend orange inside silicone 
elbow in the engine bay from Step 14. Secure the other remaining 90* silicone elbow 
between the MAF and throttle body. The MAF will require two of the larger T-Bolt 
clamps, take note. Tighten all the clamps  



Plug the MAF wiring in at both ends and ensure to secure the wiring away from moving 
parts. Note the red tab on the MAF connector, facing towards you is a good test of 
whether the sensor is pointed in the correct direction (open window towards pass side) 

 

Step 15: A/C Line Modification  

Let’s complete the installation on the driver’s side. The A/C line that runs right infront of 
the Procharger unit needs to be modified so it is out of the way of the inlet tubing. This 
will require some careful bending but you should be able to do this without 
disconnecting the line and releasing the A/C Freon, just take your time and pay close 
attention to what you’re up to. You can bend this line towards the radiator hose or away 
from the radiator, as you desire, the former will require less bending. Use the inlet 
Cobra elbow to judge whether more bending is required. 

 

Step 16: Install Air Filter and Tubing 

Attach the K&N air filter to the large 45* aluminum intake elbow pipe. The 90* silicone 
coupler that attaches to the Procharger will have a shorter leg that’s a large diameter, 
this goes over the Procharger inlet. Ensuring to check clearance from the A/C line, slide 
the aluminum pipe  up from the fender-well and into the silicone 90* elbow, angling so 
the filter faces forward and has clearance. Once you’re happy with the alignment, 
tighten down the clamps. The clamps on the silicone elbow are high torque band 
clamps and can be tightened snug with a ¼” ratchet with an 8mm socket, don’t go crazy 
but they’re meant to be tightened more than a flat-blade screwdriver if you need to. 



 

 

 

 

 



Step 17: Install Catch Can System 

Your catch can will include a bunch of new preassembled hoses and the can itself with 
mounting brackets. The can can be mounted as shown off of one of the bolts on the 
brake vacuum pump (Note: picture may show older catch can). Remove the nut from 
the bottom of the right side bolt, install the bracket and reinstall the nut.  

Before installing, if you have the two port catch can, note and remember which is the In 
and which is the Out, you may find it hard to read once installed. 

 

Disconnect the line that runs from the back of the passenger’s side valve cover to the 
top of the intake manifold. There’s a tab to slide sideways and the fitting will slide up 
and off of the PCV fitting on the valve cover. Rotate the fitting on the manifold counter 
clockwise and watch for the locking tabs to be released, then it can be pulled upward.  

Locate the new line that has the same fitting for the PCV valve, click it into place on the 
valve cover fitting, then run it to the catch can and connect to the “In” port, trim the hose 
length as you desire as I try to send them slightly long. 

Locate the new line that has a silver check-valve in it; the end that the check valve is 
closest to will connect to the inlet elbow on the Procharger, it draws a vacuum source 
from it at full throttle, connect it now to fitting preinstalled on the elbow or locate the 
predrilled hole in the elbow and slide the barb fitting into the silicone elbow securely. 
Connect the other end which will have a T fitting in it to the catch can on the “Out” port.  

Locate the hose that has the same fitting in it as the intake manifold end previously 
removed, it’ll also have a check valve in it. Insert and rotate clockwise 90* to secure. 



Run the other end of that hose to the T fitting on the previously installed hose. Trim the 
hoses as you desire for a good fit. 

Locate the long hose with a short piece of larger pliable silicone hose at the end. This 
runs from the air filter neck fitting to the rear driver’s side valve cover fitting. Attach the 
pliable silicone end to the rear driver’s side valve cover fitting, ensure it’s nice and snug. 
Run as desired down to the air filter, trim at the filter end and attach to the preinstalled 
plastic barb fitting on the filter neck. 

 

 

Step 18: Install Spark Plugs, install MAP sensor on 12-15 models 

The kit came with 6 new spark plugs, AC Delco part number 41-147. You’ll need a 
spark plug socket and a long extension. You may find you need to remove the EVAP 
solenoid to get the middle passenger’s side spark plug out, otherwise this is a simple 
remove coils, remove plugs and reinstall. The plugs come pregapped at 0.035”, check 
and verify before installing is recommended. 

On 2012-15 models, the MAP sensor is located ontop of the intake manifold towards the 
back of the engine. Simply unplug the electrical connector, remove the one Torx bolt, 
remove the sensor and replace with the one sensor from the kit. Note: 10-11 owners do 
not have a MAP sensor on your engine, skip this step and just do the spark plugs. 



Step 19: Install Washer Fluid Reservoir 

The new washer reservoir will come as the bottle and pump and hardware separately. 
Behind the driver’s side headlight in the airbox area, remove the grounding stud.  

Next take the L bracket, spacer, and one of the nuts. This goes on the airbox stud on 
the strut tower. Slide the spacer on the stud first, then short leg of bracket, and nut. 
Leave it loose for the moment. Note that the bracket when installed properly will face 
with the inside bend of the L towards the engine, to bring the bottle further away from 
the Vortech. 

The bottle will have the fatter end towards the headlight and the thinner end towards the 
strut tower. Take the Z bracket and attach its shorter leg to the headlight end of the 
bottle using a nut and bolt provided, you’ll be able to access the bolt head but not 
enough to put the whole screw in once the bottle is in.  

Place the bottle in place and use one of the new bolts in the kit to secure the other end 
of the Z bracket where the grounding stud was. Use a nut and bolt, secure the bottle to 
the longer end of the L bracket. With the bottle in place, tighten the bolts as you see fit 
to give a good placement of the bottle. 

Once installed, take the wiring extension harness that came preinstalled into the new 
pump, and plug it into the factory pump plug at the harness. You’ll need to trim the 
rubber washer fluid line as needed to secure to the outlet on the new pump. 

 



Step 20: Reinstall Front Bumper 

Time to reinstall the front bumper fascia and button up the car. Refer to the original 
disassembly process, and just do everything in reverse. 

Step 21: Fill With Oil and Final Checks Under The Hood 

Using the included package of supercharger oil, add one full 6 ounce bottle of oil to your 
Procharger unit. There are bottles for subsequent oil changes and this can be 
purchased at Summit Racing, Jegs and many other performance outlets, always use 
Procharger genuine oil. 

Time to check everything you’ve installed. Look for the following items: 

- Things are clear from the serpentine belt 
- Things are clear from the exhaust downpipes 
- Intercooler piping isn’t clunking against the subframe, adjust if so to correct 
- Check all clamps are tight 
- Check that the catch can fittings connections are good  
- Check coolant level and add 
- Add fluid to the Power Steering Reservoir to the cold mark 

Step 22: Flash Tuning 

Following the supplemental instructions included at the end of this guide, flash the new 
supercharger tune to the vehicle that you’ve been emailed back from Overkill.  

 



What’s normal and not to hear with this supercharger 

The supercharger will include lots of new noises. The Procharger itself will have a 
whirring sound and can sound a little like a rock tumbler to some; this is perfectly normal 
for these units. The blow off valve will sound like air rushing out and you’ll hear this at 
idle, decelerating or mild cruising at city driving speeds, this is normal operation for this 
valve in a supercharger setting. If you hear any knocking like a hammer, check the belt 
tension and ensure the tensioner isn’t at its furthest travels, that will typically cause that 
sound; changing belt sizes or the size of the tensioner pulley are the fixes. 

Maintenance On The Supercharger Kit 

The Procharger will require its first oil change at 500 miles, and then regular oil changes 
every 6000 miles or 1 year. Check the oil level on a regular basis in between changes. 
Use only the Procharger specific brand of oil. 

Your catch can should be drained at least every oil change or at least twice per year. 
Check it often at first if you’re unsure, you’ll get a feel for how often it fills.  

Strongly recommend the use of synthetic oil like Amsoil, Mobil 1 or Pennzoil Platinum  
in your engine, differential and transmission, with quality filters, and change at factory 
“severe service” intervals or earlier, which you’ll find specifies transmission and 
differential oil changes every 45 thousand miles. 

Should you need a new supercharger belt or a different length supercharger belt, take 
note of the part number on the belt provided, it will be a Gates belt typically starting with 
K080xxx or an AC Delco starting with 8Kxxx. The following Gates belt part numbers are 
listed from longer to shorter (larger last 3 numbers are longer, they specify the belt 
length in inches) 

K080560 > K080558 > K080553HD > K080550 > K080547 > K080545 > K080537 

Check the condition of the air filter every 6 months at least. The hydrophobic prefilter 
will aid greatly in keeping the filter clean and can be wiped off with a water damp rag. If 
the filter needs cleaning, remove from the vehicle and use the manufacturer’s 
recommended cleaning procedure. 

 

 

 

 



Warranty On Supercharger Kit 

The Vortech is warrantied for 6 months by Vortech from date of purchase for defects of 
materials following their warranty guidelines. The Overkill warranty on the remaining 
parts is for 1 year from date of purchase on items like the tensioner failing and making 
noise, if a silicone elbow developes a split, if the intercooler develops a crack. Items that 
aren’t covered are items that come from abuse, misinstallation, improper maintenance, 
collisions, acts of god, or from additional non kit related modifications, and can include 
for example your tires contacting the air filter at full lock and wearing a hole in it, or 
stripping out the threads in the mounting plates due to overtightening.  

This warranty covers replacement of the part only. It does not cover labor costs to 
diagnose or to remove or replace the component. It does not cover any towing costs. It 
does not cover any downtime costs on the vehicle. 

 

What If I Need A New… 

The supercharger kit has been designed with no components that will require 
extraordinary replacement schedules. There are of course items on the kit that won’t 
last forever. Here’s a list of wearable parts: 

Supercharger Belt – Take note of the Gates belt part number on your belt, write it down 
if you need to. It’ll start with a K, for example K080547. These are available from NAPA 
and elsewhere. You can also replace K080 with 8K and find the same belt under AC 
Delco (example 8K547) 

Tensioner Pulley – Dayco 89094  

Spark Plugs – AC Delco 41-147 (application 2016 Cadillac ATS-V 3.6 Turbo) 

Washer Fluid Pump – Reference a 2000 Ford Crown Victoria 

Air Filter – K&N RE-0950 and prefilter 22-8033PK 

 

 

 

 

 



HP Tuner instructions 

Step 1: Install software on your PC 

In the HP Tuners kit is a USB stick, and on it is the software to install on your PC You 
can also find the HP Tuners software on their website which will be their most up to date 
versions and may be the best way to go, you can find it at 
www.hptuners.com/downloads Download the “Download VCM Suite: Latest Full 
Version” in the upper left, and if you need them you can also download the MPVI2 
Drivers on that page. Plug your HP Tuners MPVI2 module into your PC using the USB 
cable, install the software. Next, open VCM Editor, go to Help > Resync Interface, and 
that’ll pole the module for your licensing information that has been preloaded; you will 
need to be connected to the internet. Ok, ready to go to the vehicle. 

Step 2: Reading your Factory Tuning 

Using the HP Tuner MPVI2 module and supplied USB cable, connect to your vehicle’s 
OBD2 port below the dash. Turn the key or ignition to “on” or “run”, so the instrument 
cluster lights up, but do NOT start the engine. If you have a push button start, press and 
hold the start button with your foot off the brake pedal for about 10 seconds to put the 
vehicle into run mode. Wait 20 seconds from turning the ignition on before you begin a 
read of any of the computer modules, to allow them time to boot up and run their startup 
system checks. Turn the radio off and the HVAC system off to conserve battery power, 
you can also turn off the headlights if its dark out. 

In the VCM Editor program, to go Flash > Read Vehicle; in the popup window that 
opens, click the Gather Information button.  

 

http://www.hptuners.com/downloads


Once it poles the vehicle, you’ll see a new pop up window with options to read the 
various computers that are supported. Always have the engine ECM computer at the 
top set to Read Entire, and if you’re an automatic transmission you’ll want the 
transmission TCM computer set to Read Entire. If you see an option for the FSCM 
which is the fuel pump computer, set this to “Do Not Read” unless you have 
instructions otherwise from me, otherwise it will cost you 1 extra credit that you’ll 
need to purchase with your own money!! 

 

With those set, click Read and let it do its thing, the read will take typically 3-5 minutes 
on most GM vehicles but if you have a Pontiac G8 3.6, a 2005-11 CTS with the 3.6, 
2010-11 Camaro 3.6, the engine computer read could take upwards of 25 minutes so 
be prepared. If you have a 2017+ GM vehicle, you may get a message that the tuning 
can’t be read at this time and try again later, if so ensure you’re connected to the 
internet to allow the HP Tuner suite to send the file to HP Tuners, and then try again in 
about 1 hour. 

 



Once completed, save the file as your name, your vehicle, and “factory” or “stock” so 
you know that this was your factory computer tuning should you ever need to access it 
again. Email the file that you just saved to willoverkill@gmail.com. I will typically get 
your tune back to you within 48 hours (excluding weekends), you can follow up with an 
email if you don’t hear in that timeframe, keep in mind it takes me an hour typically to 
write the initial tuning for every vehicle I do so it won’t be an instantaneous process!  

Step 3: Flash your Overkill Tunes  

When you receive back your Overkill tune files, they’ll be labelled as Overkill or OK and 
then Supercharger. Subsequent revisions will be labelled Mod1, Mod2 etc. If you’re 
automatic transmission equipped, you’ll have your Overkill transmission settings in this 
file.  

At some point in the flash, you’ll be asked to license the vehicle and file. When the 
screen comes up, click Licensing Options, select Specific Vehicle and click ok to license 
your vehicle with the included credits. 

To flash the tune to the vehicle, open up VCM Editor, go to File > Open and select the 
tune that you wish to run. Go to Flash > Write Vehicle, and for the computer options that 
come up you’ll want to see Write Calibration selected.  
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Turn the key or ignition to “on” or “run”, so the instrument cluster lights up, but do NOT 
start the engine. If you have a push button start, press and hold the start button with 
your foot off the brake pedal for about 10 seconds to put the vehicle into run mode. Wait 
15-20 seconds from turning the ignition on before you begin a write of any of the 
computer modules, to allow them time to boot up and run their startup system checks. 
You can now click Flash and let the system upload the tunes to your vehicle. Do not 
interrupt this process by using the computer for other things, disconnecting the cable by 
accident or otherwise, fidgeting with the stereo or hvac or etc, it is very very important 
not to interrupt the writing process, you may leave your vehicle inoperable! This is rare 
but can happen. If for any reason the flashing process is interrupted, do not turn off the 
ignition, check all your connections and try immediately to flash again, you should see 
the HP Tuner suite recover and reboot the flashing process. 

Once the flashing process is computer, and you see Write Complete for all the 
computers selected, you can turn off the ignition, wait 10 seconds, and then start your 
vehicle. If you have a push button start, turn the ignition on and then off again, you may 
find it doesn’t try to start the first time, just try again and it should fire up. 

Your vehicle will now be programmed with Overkill tuning! 

 

Step 4: Taking a Driving Scan 

While you’ve received your Overkill tunes programmed to your modifications, it’s always 
beneficial to take a driving scan and send that scan data to Overkill so your tune can be 
further refined as needed.  

Open the VCM Scanner, connect your laptop to the vehicle with the cable/module, start 
your vehicle up (this time its ok to use this suite while the engine is running). Go to the 
excel like table on the left side of the scanner, to the top and you’ll see a button that 
says Recent Channel Configs, click on that, Open Channel Config and select the .xml 
file that I’ve emailed with your tunes (email me back for one if you don’t see it attached).  



 

Now go to Vehicle > Connect and Vehicle > Start Scanning, confirm that you see the 
parameters on that table in the right hand column changing as it gets information from 
the computer. 

Now go ahead and drive the vehicle. Take about a 10 minute scan, nothing too short, 
try not to be overly long as the file becomes huge to try and sift through on my end, and 
include your regular driving habits, include some brief full throttle if you can such as a 
highway ramp entrance or a 0-60 run in an appropriate area, and at the end of the scan 
include about 30 seconds of idling. When finished, go to Vehicle > Disconnect, then Log 
File > Save Log File As, save it as your name and what tune you’re running (John Smith 
OK93 for example) and add the date if you choose, then email me that file to 
willoverkill@gmail.com. I’ll look at the data, revise the tune as needed and email that 
back within 5 business days. 
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